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1. Introducing RoboCell 
RoboCell is a software package that integrates four components: 

 SCORBASE, a full-featured robotics control software package, which provides a user-friendly tool 
for robot programming and operation 

 A Graphic Display module that provides 3D simulation of the robot and other devices in a virtual 
workcell 

 CellSetup, which allows a user to create a new virtual robotic workcell, or modify an existing 
workcell 

 3D Simulation Software Demo to demonstrate RoboCell’s capabilities 

This manual covers all features and operation of the Graphic Display and CellSetup modules. It provides 
support for all current versions of RoboCell. 

SCORBASE menus and commands are described in the SCORBASE User Manual. 
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‎2.1 System Requirements 

2. Starting RoboCell 
The following sections describe the steps involved in starting RoboCell.  

2.1. SYSTEM REQUIREMENTS 

For best performance, the following system is recommended: 

 Intel Core i5 2400 GHz 2400 GHz or higher, equipped with CD drive   

 At least 1GB RAM (4 GB for Windows 7 and higher)  

 A hard drive with at least 200 MB of free disk space 

 A mouse 

 USB port 

 Windows XP/7/8/8.1/10 

Note: Your operating system might have additional hardware requirements. 

2.2. SOFTWARE LICENSING 

The RoboCell software is protected by a licensing agreement. Full details on the Intelitek software 
licensing are provided in the Intelitek Software Licensing Guide. 

2.3. INSTALLING THE SOFTWARE 

The RoboCell software is supplied on a CD which also contains SCORBASE. Close any applications that 
are open before proceeding with the installation procedures. If you are about to reinstall the software, 
or install a newer version to an existing RoboCell directory, it is recommended that you back up any 
existing user-created files before you begin the installation. It is also recommended that you remove the 
previous RoboCell version for Windows installation using the software's Uninstall utility (For more 
information on uninstalling RoboCell, see ‎2.4.2 Uninstalling RoboCell on page 7).  

To install SCORBASE: 

1. Insert the CD into the CD-ROM drive to start the installation procedure. 

2. If the installation procedure does not start, either: 

a. From the Windows task bar, click Start | Run and type D:Setup (where D: is your CD drive), or  

b. Using Windows Explorer, explore the CD drive and click  Setup. 
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‎2.3 Installing the Software 

3. Wait until the Welcome window is displayed. 

 

4. Click Next. The License Agreement window is displayed. 
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‎2.3 Installing the Software 

5. Review the Intelitek software license agreement. You must accept the terms of this agreement in 

order to proceed with the installation. To accept, select Yes. The Software Selection Window is 

displayed.  

 

6. Select RoboCell for ER 4u. The robot that you select becomes the default robot while you are 

working in RoboCell, although you can choose to open a new project and work with a different 

robot. See the Hardware Setup option in the Options Menu.  

Click Next. The Setup Type window is displayed. 
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‎2.4 RoboCell Utilities 

7. Select the desired language and click Next. The Choose Destination Location window is 

displayed. 

 

8. The default destination folder for the files is: \Intelitek\RoboCell.  

Click Next to accept the default, or click Browse to select another folder, and then click Next to 

display the Select Program Folder window. 

9. Click Next to complete the installation procedure. 0. 

2.4. ROBOCELL UTILITIES 

These utilities are available from the RoboCell group: 

 CellSetup 

 3D Simulation Software Demos 

 Uninstall 

2.4.1. 3D Simulation Software Demos 

Demonstration files included with the software allow you to observe the capabilities of RoboCell. To run 
these demo files, perform the following: 

1. Activate the demos by selecting Start | Programs | RoboCell | 3DSimulation Software Demos. 

The default demo opens and starts automatically. 

2. To view another demo file, select File | Open, or click the Open  icon. 
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‎2.5 Quitting the Software 

3. Select the desired *.DMO file from those listed in the Open window. The program starts 

automatically. 

4. To stop a demo, select File | Stop. 

5. Use the Menu options or Toolbar icons to navigate in the virtual cell. See Chapter ‎4 CellSetup on 

page 11for full details. 

6. To exit the Demos utility, select File | Exit. 0. 

2.4.2. Uninstalling RoboCell 

To uninstall RoboCell: 

1. From the RoboCell program group, select Uninstall. 

2. Follow the instructions which are displayed on the screen. 0. 

The Intelitek Software Licensing Guide provides full details on the procedures for protecting your 
license, transferring the license from one PC to another, and returning the license to Intelitek for 
retrieval at a later time. 

2.5. QUITTING THE SOFTWARE 

To close RoboCell (or its components), perform any of the following: 

 From the menu bar, select File | Exit. 

 Click the Close box in the SCORBASE Title Bar. 

 Press [Alt]+F4.  
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‎3.1 Rotate 

3. Graphic Interface 
The 3D image you see on your screen is the output of a virtual video camera fitted in the workcell. You 
can use the mouse to manipulate the image. 

The Graphic Display and CellSetup in RoboCell have the same graphic interface. 

3.1. ROTATE 

To rotate the scene (move the camera around the center of the image): 

1. Place the cursor anywhere in the graphic window and click the right mouse button. The cursor 

changes to a magnifying glass. 

2. Keep the right mouse button depressed and drag to the right to rotate the scene 

counterclockwise. 

3. Similarly, keep the right mouse button depressed and drag to the left to rotate the scene 

clockwise.  

 

The image rotates around its center point. To change the center point, use the Redirect Camera tool 
(See ‎4.5 View Menu on page 15.). 

3.2. ZOOM 

To zoom in or out: 

1. Place the cursor anywhere in the graphic window and click the right mouse button. The cursor 

changes to a magnifying glass. 

2. Drag up to zoom in. 

3. Drag down to zoom out.  
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‎3.3 Angle 

The image zooms in and out while its center point remains fixed. To change the center point, use the 
Redirect Camera tool (See ‎4.5 View Menu on page 15.). 0. 

3.3. ANGLE 

To change the angle of the overhead scene (to move the camera up or down), either click on the vertical 
scroll bar (red arrow) and drag it up or down or use the mouse scroll wheel. 

 

The camera moves up or down while the center point of the image remains fixed. To change the center 
point, use the Redirect Camera tool (See ‎4.5 View Menu on page 15.). 

3.4. BRIGHTNESS 

To change cell illumination (bright or dark), click the right mouse button and drag in any direction while 
simultaneously holding down the Ctrl key. The cursor changes to a light bulb. 
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‎4.1 Opening CellSetup 

4. CellSetup 
CellSetup allows you to create a new virtual workcell or modify an existing one. A workcell created using 
CellSetup can be theoretical or a replica of actual robotic installations. 

After creating a workcell, you can open it in RoboCell, where you can define positions, write programs 
and run them. If a controller and a robot are connected to your computer, you can switch RoboCell to 
On-Line, and run the virtual robot in the virtual cell, together with the real robot in the real cell. 

4.1. OPENING CELLSETUP 

To open CellSetup: 

1. Select Start | Programs | RoboCell | CellSetup. After initialization, this screen is displayed: 

 

2. Select File | New to create a new workcell. At this stage, you can choose to work with either the 

default robot that you selected during installation or another robot. 

 

3. If you want to open an existing workcell, select File | Open from the Opening Screen. For further 

details, see ‎4.3 File Menu on page 13. 
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‎4.2 CellSetup Window 

4. If you are working in RoboCell and you want to modify the current workcell you are using, select 

File | Edit 3D Model. CellSetup opens with your current workcell. At this point, you cannot open 

another cell. Therefore, the New and Open options are not available. When you exit CellSetup 

after having completed your modifications, you are returned to RoboCell where the newly edited 

cell is displayed. 0. 

4.2. CELLSETUP WINDOW 

This image shows an existing workcell in the CellSetup window.  

 

The window comprises: 

 A menu bar containing all command menus and options 

 A toolbar containing icons for the most commonly used options 

 A working area containing the workcell objects 

 A status bar displaying RoboCell status messages 
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‎4.3 File Menu 

4.3. FILE MENU 

The file menu is shown here: 

 

Cell data is stored in a *.3DC file. The File menu contains the usual Windows functions that allow you to 
load and save 3DC files, and to exit the software. In addition, you can open the most-recently opened 
workcell files from this menu. 

Note: Only one workcell file can be opened at a time. 

This table summarizes the options in the file menu.  

File Menu 

Icon Option Summary 

 
New 

After you select the robot that you want to work with (ER 4u), opens a new, 
untitled, CellSetup file, and opens the New Object menu. 

This icon and menu option are available only if CellSetup is opened from the 
Programs menu. 

 
Open 

The Open dialog box is displayed. You can open an existing CellSetup file (e.g., 
robo1.3DC). The cell defined in the file is displayed, and the New Objects menu 
opens. 

This icon and menu option are available only if CellSetup is opened from the 
Programs menu. 

 
Save 

Saves the current placement of all objects in the cell to a CellSetup file. The 
default file extension is 3DC. 

 Save As… 

Saves the currently active CellSetup file under a new file name. 

 Note: Peripheral axes are redefined (through the robot’s 

properties menu) in the new file created by the Save As operation. 
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‎4.4 Edit Menu 

File Menu 

Icon Option Summary 

 Print  Prints the currently displayed 3D image. 

 Print Preview Opens a dialog window that shows how the printed cell appears on paper. 

 Exit Closes CellSetup. 

 

4.4. EDIT MENU 

The edit menu is shown here: 

 

The Edit menu contains functions that allow you to add, delete, and relocate objects. Through this menu 
you can also set the floor size and cell textures. 

This table summarizes the options of the edit menu.  

Edit Menu 

Icon 
Option Summary 

 
New Object 

Opens/closes the New Object menu. From this menu you can select 
objects to add to the cell. For detailed information, see ‎4.8 New Objects 
Menu on page 20. 

 
Delete Object 

Activates the delete mode in order to delete an object from the cell. 

Using the cursor, point and click the object you want to delete. Click Yes 
to confirm the deletion. If you click No, the delete mode remains in effect, 
allowing you to select and delete another object. 

Press [Esc] to cancel the delete mode. 

 
Drag Object 

Activates the drag mode in order to relocate an object in the cell. 

Using the cursor, point and click the object you want to relocate and drag 
it to its new position. The drag mode remains in effect until you select 
another option or press [Esc]. 

 
Floor Size 

Opens the Set Floor Size dialog box where you can set the X and Y 
dimensions of the cell. Click OK to confirm the new size or Cancel to close 
the dialog box. 
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‎4.5 View Menu 

Edit Menu 

Icon 
Option Summary 

 
Set Textures… 

Opens a sub-menu listing cell textures: backdrop, ground, building and 
floor. Select Picture and click Edit to browse for a desired .bmp file or 
select Color and click Edit to define a color for the specified texture. 

4.5. VIEW MENU 

The View menu enables control of the position and name labels and the virtual camera position. 
Through this menu you can toggle the display of the Toolbar and Status Bar.  

The view menu is shown here: 

 

The options of the View menu are summarized in this table: 

View Menu Options 

Icon Option Summary 

 

Controller 
Setup 

The robot controller has eight digital input and eight digital output connections. 
Certain objects that are placed in the cell have a predefined number of input 
and/or output positions at which they can be connected to the controller.  

In addition, peripheral devices can be connected to axes 7 and 8 of the controller 
(see‎4.8.1.1 Robot Configuration on page 21 and ‎4.8.2 Peripheral Axes on page 23 
below). 

Through the Controller Setup dialog box (below) you can view the defined 
objects and modify their input, output and axes connections under the 
appropriate tab. 
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‎4.5 View Menu 

View Menu Options 

Icon Option Summary 

 

Devices that have not yet been connected are listed under Not connected. 

To connect a non-connected device, click the device and drag it to a free 
input/output/axis. A plus (+) sign is displayed next to the cursor. 

To modify an existing connection, drag the input/output/peripheral to a new 
setting. A swap sign is displayed next to the cursor. If you drag the device to a 
setting that already has a connected device, the new device replaces the 
previous device which is disconnected and relocated under Not connected. 

To disconnect input/output/peripheral, drag the object to the Not connected 
list. A minus (-) sign is displayed next to the cursor. 

 
Show Names  

Shows/hides the Object Name labels (see the image below). When you select 
this option, a label on each object shows its name. Names are assigned by the 
software but can be renamed by the user in the object’s properties menu. 

This option cannot be selected together with Show Positions. 
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‎4.5 View Menu 

View Menu Options 

Icon Option Summary 

 

 

Show 
Positions 

Shows/hides the Object Position labels (see the image below). When you select 
this option, a label on each object shows its position. The coordinates that are 
displayed on the object’s label indicate the object’s position (X, Y coordinates) 
relative to the cell’s point of origin. 

This option cannot be selected together with Show Names. 

 

 
Redirect 
Camera 

Allows you to select a different focal point in the graphic display of the cell. 

To change the center point of the graphic display window, click the icon or menu 
option. Use the cursor to point and click any spot in the scene. This now 
becomes the new center point of the display. All zooming of the view focuses on 
this point; all rotations revolve around this point. 

Press [Esc] to cancel the Redirect Camera mode. 

 
Drag 3D 
Frame 

Activates the drag mode in order to relocate the entire cell in a new position. 
Click anywhere in the image and drag the entire cell to a new position. 

The drag mode remains in effect until you select another option or press [Esc]. 

 
Camera Top 

Resets camera position to display an overhead view of the cell. You can rotate or 
zoom in/out of this view. Use the vertical scroll bar or the mouse scroll wheel to 
alter the angle of the view. 

 
Scene Origin 

Shows the origin of the cell at floor level (under the center of the robot’s base) 
as a red cross marked with X and Y axes. The positions of all objects are defined 
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‎4.6 Help Menu 

View Menu Options 

Icon Option Summary 

as relative to this point of origin. 

When manipulating the graphic display, the cross may disappear momentarily. 
Rotating the view does not change the X and Y dimensions of the cell. 

 
Toolbar Shows/hides the Toolbar. 

 
Status Bar Shows/hides the Status bar. 

4.6. HELP MENU 

The options of the Help menu (shown here) are summarized in the table below.  

 

Help Menu 

Option Summary 

Help Opens RoboCell on-line help 

About Shows the RoboCell software version 

Registration 
Opens the Software License Window for registration, and for transferring 
RoboCell license to another computer. (See the Intelitek Software licensing 
Guide for further information.) 

4.7. OBJECTS 

You can place a number of objects into the workspace using RoboCell. 

4.7.1. Object Placement 

To place a new object in the cell, do the following: 

1. Double click the object’s name in the New Objects menu. 

2. Move the cursor into the graphic scene. 

3. Point and click the location where you want to place the object. You may need to wait a moment 

for it to be displayed. Do not double click. 0. 

If you have trouble placing an object in the exact spot you want, zoom in and out, and adjust the view 
from top to bottom until you can more accurately place the object. 

Most objects are placed in the cell automatically at table level. These objects look as if they float in 
space unless a table has also been placed in the cell. 
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‎4.7 Objects 

The height of some objects (template, jig, cylinder and cube) is determined at the time they are placed 
in the cell. 

If, for example, you click the conveyor when placing a cube in the scene, the cube is placed on the 
conveyor at the proper height. 

It is recommended that a table be placed in the cell before any of these four objects is added to the cell. 
Otherwise, these objects may be set on the cell floor and are hidden when a table is added. 

Once an object’s height is set, it cannot be changed in CellSetup. For example, you cannot move the 
cube from the table onto the conveyor. Moving an object whose height has been set causes it to float in 
space or penetrate another object. If the setup is saved with a floating object, the object falls to the 
surface below it when the file is loaded in RoboCell. 

To change an object’s height in CellSetup, you must delete the object and create a new one. 

To move an object, simply click it and drag it to another position. Or use the object’s properties menu to 
set precise position coordinates. 

The robot cannot be dragged to another position. Its position can be changed only by means of its 
properties menu. 

4.7.2. Object Configuration 

Selecting some of the objects from the New Object list opens a configuration dialog box for defining the 
object’s permanent attributes (such as size and color). Attributes must be set before an object can be 
placed in a cell. 

An object’s configuration cannot be changed once the object has been placed in the cell. You must 
delete the original object, and select and configure the object again from the New Object list. 

Objects that have configuration options are described later in this section. 

4.7.3. Object Properties Menu 

Double-clicking an object that has already been placed in the cell opens the Object Properties menu. 

 

Object properties can be changed at any time during cell setup. 
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‎4.8 New Objects Menu 

All Object Properties menus contain the object’s name and the following options. Some objects have 
additional properties which are described in the individual sections. The Object properties menu is 
shown here. A table that summarizes the options is shown below.  

Object Properties Menu 

Option Summary 

Rename 

Every object is automatically assigned a name and a number when it is placed in the cell. This 
name is displayed in the object’s properties menu. The number indicates the order in which 
objects of the same type were added to the cell (e.g., FEEDER1, GFEEDER2). 

Clicking Rename opens a dialog box that allows you to change the name of the object. The 
number can be changed or deleted. 

Rotate 

Objects can be rotated to any degree, in the minus (clockwise) or plus (counterclockwise) 
direction. 

Clicking Rotate opens a dialog box that allows you to change the object’s orientation. 

The degree of rotation is always defined relative to the object's default (predefined) orientation. 

Position 

The cell has a point of origin at table level defined by XY coordinates (0,0). All object positions 
are defined in XY coordinates relative to this point of origin. 

For most objects these XY coordinates indicate the center of the object’s base. 

By default, the robot is placed in the cell with the center of its base (i.e., the robot's point of 
origin) at the cell’s point of origin. 

Clicking Set Position opens a dialog box that allows you to change an object’s X and/or Y 
coordinates. 

Show Text 

Shows/hides the label for the selected object. 

This option can only be activated when View | Object Names or View | Object Positions is 
selected. 

4.8. NEW OBJECTS MENU 

New objects are added to the cell using the New Objects menu. The objects are arranged in groups 
(robots, peripheral axes, etc.). 

To add a new object to the cell, click the desired object group (folder) and then select the specific object. 
The groups are detailed below. 
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‎4.8 New Objects Menu 

4.8.1. Robots 

The robot, which is automatically placed at the cell’s point of origin, should be the first object you place 
in the cell. 

The robot cannot be dragged to a new location. Its position can be changed only by means of the robot’s 
Properties menu (see ‎4.7.3 Object Properties Menu, page 19). 

Only one robot can be placed in the cell. 

To add a robot to the cell: 

 Click Robots. Select ER 4u. 

4.8.1.1. Robot Configuration 

A dialog box titled ROBOT1 opens allowing you to define whether or not the robot is mounted on a 
linear slidebase (LSB), a peripheral device that enables linear movements of the robot unit. 

 

By default, the robot is set to have no slidebase. When you click OK to confirm this option, the robot is 
immediately placed in the cell. 

Alternatively, these slidebase options are available: 

 Slidebase 1.0m, Belt drive 

 Slidebase 1.8m, Belt drive 

If you select a slidebase, the Robot Configuration dialog box looks as follows: 
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‎4.8 New Objects Menu 

 

Robot Configuration Dialog Box Properties Tab 

LSB Height By default, the LSB Height is 100 mm, which is the actual height of standard SCORBOT 
slidebases. 

Robot Angle By default, the robot is mounted perpendicular to the slidebase at 90º. 

 
If you select a slidebase, the robot and the slidebase are treated as one object in the cell. 

4.8.1.2. Peripherals tab: 

To select a controller peripheral axis that controls the slidebase (and any other peripheral device that 
has already been defined), click the Peripherals tab. 

 

Peripheral devices can be connected either to axis 7 or to axis 8. To connect a device listed under Not 
connected, click it and drag it to one of the free controller axes. If you drag the device to an axis that 
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already has a connected device, the new device replaces the previous device which is disconnected and 
relocated under Not connected. 

You can leave the slidebase not connected at this stage and connect it later using View | Controller 
Setup, or the Controller Setup icon. 

4.8.1.3. Additional Robot Properties 

In addition to the standard object properties (see ‎4.7.3 Object Properties Menu on page 19), this option 
is listed as a Robot property: 

Additional Robot Properties 

Show Envelope Displays the span of the robot’s working range. This option facilitates the placing of 
objects within the reach of the robot. 

4.8.2. Peripheral Axes 

Peripheral devices include a motor with speed and position control. They are connected as axis 7 or axis 
8 of the controller. 

 

To place a peripheral device in the cell, click Peripheral Axes and select the required device. 

If you select either of the slidebases or a linear table, you are asked to define the LSB Height as 
described in ‎4.8.1.1 Robot Configuration on page 21. 

For all devices you have the opportunity of allocating the controller axis at this stage (see ‎4.8.1.1 Robot 
Configuration on page 21). 
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4.8.3. I/O Devices 

RoboCell I/O (input/output) devices can be connected to any free input/output terminal. The robot 
controller has eight digital input and eight digital output connections. 

To place an I/O device in the cell, click the I/O Devices group and select the required device. 

 

4.8.3.1. Experiment Table 

An experiment table includes the following input and output devices: 

 Four (4) touch sensors – (input device). These are activated when there is a part on the switch, 
or something activates the switch. 

 Lamp (output device) 

 Buzzer (output device) 

An experiment table with Input/Output Devices is shown here.  
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When you select Experiment Table, this dialog box is displayed, enabling you to define the input and 
output connections: 

 

Although one of the experiment table inputs may be disabled if the input is later defined for another 
device, all other switches remain connected to their defined inputs. 

In RoboCell, a sound is emitted when the outputs that control the buzzer and lamp are turned on and 
off. The experiment table outputs use the Windows sounds associated with the following events: 

 Buzzer On: Exclamation 

 Buzzer Off: Critical Stop 

 Lamp On: Asterisk 

 Lamp Off: Information 

In addition, the lamp in the Graphic Display turns bright red when its associated output is turned on. 

4.8.3.2. Sensor 

RoboCell includes digital sensors that can be configured to detect specific objects based on their color 
and/or material (metal, plastic, wood, etc.). The objects are listed in the Materials group and their 
properties are defined when they are placed in the cell (For more information, see ‎4.8.10 User Objects 
on page 39.). 

When you select Sensor, this dialog box is displayed, enabling you to define the color/material to which 
the sensor is sensitive, as well as the sensor’s height. 

The sensor configuration window is shown here:  
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Sensor Configuration 

Option Description 

Color Detect By default, the sensor is set to detect all colors. To set it to a specific color, uncheck All 
Colors. Click Color Detect to open a color palette from which you can select the required 
color. 

If the sensor is configured to be sensitive to All Colors, the sensor in the cell is colored 
different shades of gray with its upper part in white. This distinguishes it from a sensor 
configured to be sensitive to gray, which is entirely gray. 

Material Detect By default, the sensor is set to detect all materials. To set it to a specific material, 
uncheck All Materials. Select a material (Metal, Glass, Plastics, or Wood) from the drop-
down list.  

Height (mm) Defines the height (above table level) at which the sensor is placed in the cell. 

The default height is 40 mm. If you increase the height, the stand on which the sensor is 
mounted appears taller. 

4.8.4. Storage Devices  

The storage devices in RoboCell enable you to store, place and retrieve objects listed in the Materials 
group. 
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4.8.4.1. Gravity Feeder 

The Gravity Feeder is an inclined plane on which objects are placed, one above the other. 

 

Unlike most objects, the feeder’s position is defined as the point at which the robot takes an object from 
the lower part of the feeder. All the remaining objects slide down the feeder to be taken in turn. 

When placing objects on the gravity feeder, you must position them in the light gray section of the 
feeder’s mouth. This is shown here: 

 

The feeder is fitted with a touch sensor (named NotEmpty) located at the lower part of the feeder. The 
sensor indicates when there are parts in the feeder, i.e., it is on when the feeder is not empty. 

4.8.4.2. Feeder (Pneumatic Feeder) 

The (pneumatic) feeder is constructed from a magazine of objects and a pneumatic cylinder fitted at the 
lower section. 

The feeder is also fitted with a touch sensor that is pressed (the input is on) when there are parts in the 
feeder (NotEmpty sensor) 

The pneumatic cylinder is controlled via a controller output. When the output is turned on, the piston 
extends, pushing out the next object. 

Cursor 



 

‎4 CellSetup 29 

‎4.8 New Objects Menu 

The robot picks the objects from the feeder output tray, and the feeder position is defined as the point 
at which the robot takes an object from the feeder. 

 

4.8.4.3. Feeder Configuration 

Configuration for the Gravity Feeder and the Pneumatic Feeder is described below. The differences 
between the two methods are indicated. 

When you select a feeder, this configuration dialog box is displayed: 
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Feeder Configuration Properties tab: 

Number of Parts in Feeder 

Defines the number of parts that are loaded in the feeder at the start of 
operation (when the cell is opened or reset). Only one material object (e.g., 
cylinder, cube) should be placed in a parts feeder. The software multiplies 
the object by the number of parts specified. Default: 0 

Height at Front of Feeder 
(Gravity Feeder only) 

Defines the height of the lower part of the feeder above the table level. 
Default: 200 

Height at Back of Feeder 
(Gravity Feeder only) 

Defines the height of the higher part of the feeder above the table level. 
Default: 280 

 

Inputs tab: 

To define the robot controller input to which the feeder’s NotEmpty sensor is connected, click the Inputs 
tab. 

Outputs tab: (Pneumatic Feeder only) 

To define the robot controller output to which the feeder is connected, click the Outputs tab. A new part 
appears in the feeder when the output is turned on. 

Feeder Properties 

In addition to the standard object properties (see ‎4.7.3 Object Properties Menu on page 19), this option 
is also listed in the Feeder Properties menu: 

Additional Feeder Properties  

Capacity Enables you to alter the number of parts loaded in the feeder after the feeder has been 
configured. 

 

Jig, Rack, Template, Buffers, ASRS and Bin 

No settings are required for these storage devices. Double click the desired device and place them in the 
cell at the desired location. 

4.8.5. Machines 

The Machines group includes four Mills (spectraLIGHT Mill 0200, proLIGHT Mill 1000, eXpertMill VMC-
0600, Super proLIGHT Mill 1000) and two Turns (spectraLIGHT Turn 0400, proLIGHT Turn 3000). A CNC 
controller controls these machines. The robot controller and the machine controller communicate 
through inputs and outputs. The machine output is the controller input, and vice versa. 
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All of these machines are configured in the same way. 

 

When you select any of these machines, this configuration dialog box is displayed: 
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Machine configuration properties tab: 

Controller Output for Doors 

Specifies whether or not the machine doors are controlled by the 
robot controller output. If the doors operate independently of the 
robot controller, they open and close at the beginning and end of 
the machine cycle. 

Cycle time (seconds) Sets the amount of time (in seconds) of the machine process. The 
default cycle time is 10 seconds.  

 

Machine configuration inputs tab: 

Controller input (machine 
output) 

The machine informs the controller that a process is being carried 
out, i.e., when the input is on, the machine is busy.  

 

Machine configuration outputs tab: 

Controller output (machine 
input) 

Closes and opens the machine door. The machine cannot start if the 
door is open.  

Controller output (machine 
input) 

Closes and opens the machine chuck. The chuck holds the object 
during the process. 

Controller output (machine 
input) 

Sets the robot controller output to which the machine is connected. 
The machine cycle starts when the output is turned on. 

To modify the configuration after the machine has been placed in the cell, double-click the machine to 
display its Object Properties menu (see ‎4.7.3 Object Properties Menu on page 19). Select Machine 
Setting to display the Configuration dialog box. 

4.8.6. Welding Tools 

The Welding Tools menu is shown here: 

  

The Welding Tools group includes: 
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 Welding Table 

 Welding Machine 

 Gun Stand 

 Welding Jig A 

 Welding Jig B 

Full details on use of the welding tools are provided in chapter ‎7 Welding Features on page 57. 

Welding Tools 

Welding Table 

The welding table holds the welding object and it should be placed in the cell just 
before or after the robot (the first object) has been placed. Most welding objects are 
automatically placed at the correct default welding table height, even if they are not 
placed directly on the welding table. 

Welding Machine 

The welding machine supplies the electrical power required to weld the materials. It is 
connected to the welding gun by a cable. You cannot save a cell containing only a 
welding gun or only a welding machine. Neither or both must be present in order to 
save the cell. 

Gun Stand 
The gun stand holds the welding gun between welding sessions. The robot picks the 
gun from the stand before starting the weld, and returns it to the stand when the 
welding is finished.  

Welding Jig A Welding Jig A is a device used to securely hold two materials being welded together in 
a T-joint.  

Welding Jig B Welding Jig B can be used for various types of welds. 
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4.8.7. Welding Materials 

The Welding Materials group includes the plate and the metal cube. 

 

Use of the welding materials is detailed in chapter ‎7 Welding Features on page 57. 

4.8.7.1. Plate  

Plate refers to the welding metal plates which are used with Welding Jig A. When you select Plate, this 
dialog box is displayed: 
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This table summarizes the options of the Plate Configuration dialog box.  

Plate Configuration Dialog Box 

Option Description 

Colors 

You can define the color of the plate to which the sensor is sensitive. The default color is blue.  

To change the color, click Colors. This opens a color palette from which you can select the 
required color. Make sure the color you select is compatible with the sensor’s detection 
definition. 

Size The default dimensions of the plates are 38 x 2 x 89 mm. These are for display purposes only 
and cannot be changed. 

4.8.7.2. Metal Cube 

When you select Metal Cube, this dialog box is displayed: 
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The Metal Cube dialog box is described in this table: 

Metal Cube Configuration Dialog Box 

Option Description 

Colors Define the color of the cube in the same way as described for the plate. 

Size The default dimensions of the cube are: 300 x 4 x 100 mm. You can modify these dimensions. 

4.8.8. General 

The General group includes a table and a computer (which is for display purposes only). 

 

4.8.8.1. Table 

It is a good idea to place the table in the cell just before or after the robot has been placed. It is also 
recommended that you place one or more tables in the cell so that objects do not float in space or lie on 
the floor. Most objects are displayed at the correct height, even if they are not sitting on tables. 
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When you select Table, this dialog box is displayed: 

 

The dialog box is described in this table: 

Table Configuration 

Option Description 

Colors To change the color, click Colors. This opens a color palette from which you can select the 
required color. 

Size 
Defines the width and length of the table. X and Y dimensions are always in accordance 
with the X and Y dimensions of the cell. (Use the View | Scene Origin option to display 
the X and Y dimensions of the cell.) 

4.8.8.2. Table Properties 

The Table Properties menu does not have a Rotate option (see ‎4.7.3 Object Properties Menu 19). 
Instead it has a Resize option for scaling the table’s dimensions. 

Table Properties 

Scale X; Scale Y 

Enter a ratio value (e.g., 2 or 0.5) in the X and Y fields. Both fields must contain a value. 
If you want to change only one dimension, be sure to enter 1 in the other field (do not 
enter 0). 

Resizing is progressive. The scale reverts to 1 each time the table is resized. 

4.8.9. Materials 

The Materials group includes objects that can be manipulated by the robot: 

 Cube 

 Cylinder 

 Ball 

 User defined parts (see ‎4.8.10 User Objects 39 below) 

You can place as many objects as needed. 
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The Materials Menu is shown here: 

 

When you select Cube, Cylinder, or Ball, the Object Configuration dialog box is displayed: 
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The options of the Object Configuration dialog box are summarized here: 

Object Configuration Dialog Box 

Option Description 

Colors 

You can define the color of the plate to which the sensor is sensitive. The default color is 
red. To change the color, click Colors. This opens a color palette from which you can 
select the required color. Make sure the color you select is compatible with the sensor’s 
detection definition. 

Object Material 
The cell sensor can differentiate between different materials. The default material is 
plastic. Other available materials are glass, metal and wood. When metal is selected, you 
can perform welding using the features described in Chapter 7, Welding Features.  

Size (mm) 
Cube: X, Y, Z 
Cylinder: 
Diameter, Height 
Ball: Diameter 

The default dimensions of the objects can be modified if desired. 

Horizontal/Vertic
al (for Cylinder 
only) 

Defines whether the cylinder is placed in a horizontal or vertical position. Cylinders that 
are placed in the lathe should be defined as horizontal. 

4.8.10. User Objects 

To insert an object or a part, select the desired part/object from the Materials/User Objects group. 

Point and click the location where you want to place the part/object. You may need to wait a moment 
for the cursor to be displayed. Do not double click.  

The User Object menu is shown here: 
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4.8.10.1. Parts 

Parts are basic shapes that can be used to simulate any type of material the user chooses. Simply click 
Part 1, 2 or 3 to add a new part to the cell. 

In RoboCell, parts are changed to show what they look like at the end of the mill or lathe machining 
process. You may design your own finished parts. 

User parts are stored as files in RWX format. The robot and machines can manipulate these objects. 
User part files are saved as PART*_0.RWX (where * represents 1, 2, or 3), and finished parts are named 
PART*_1.RWX. The files are located in the SBWSIMn RESOURCE folder. 

4.8.10.2. Objects 

The objects included in the User Objects group are for illustration purposes only. User Object files are 
named USER*.RWX. The files are located in the SBWSIMn\RESOURCE folder. 

Advanced users who know how to create 3D objects in RWX format can design and use such objects in 
the robotic cell. No more than three user-defined parts and eight user objects may be used at one time. 
For further directions on designing user parts/objects, see ‎4.8.11 Designing User Parts and Objects on 
page 40. 

4.8.11. Designing User Parts and Objects 

RoboCell invites you to design your own parts and objects. Part design is covered in the sections below.  

4.8.11.1. Modify an Existing User Part File 

You may change the existing user part to create your own user part. To modify an existing user part, do 
the following: 

1. Open the SBWSIMx folder. 

2. Open the RESOURCE folder. 

3. Using a text editor that saves files in plain ASCII format, such as Notepad, open one of the 

existing user part files (PART1_0.RWX, PART2_0.RWX or PART3_0.RWX). The file looks like the 

following example: 

 ModelBegin 

 TransformBegin 

  Color 0.0 1.0 1.0 

  Surface 0.4 0.3 0.2 

  Opacity 1.000000 

  LightSampling Facet 

  GeometrySampling Solid 

  TextureModes Lit 

  Texture NULL 

  ClumpBegin 

 Translate 0.0 0.0251 0.0 
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   Tag 1 

   Block 0.05 0.05 0.05 

 ClumpBegin 

 Tag 2001 

 Color 1 0 0 

 Opacity 1 

 Block 0.03 0.02 0.07 

 ClumpEnd  

  TransformEnd 

 ModelEnd 

4. Edit the file to create your own part. 

5. Save the file. Since you can only have three user part files at a time, you must replace the 

original file. Do not change the file name. 

6. To create your own finished part, edit the Part*_1 file. 0. 

If you do not want to create a finished part, delete the Part*_1 file. 

4.8.11.2. Create a New Part/Object File 

If you can create your own user part and user object files, perform the following: 

1. Open a text editor that saves files in plain ASCII text, such as Notepad or DOS Edit. 

2. Write the program to create your own part. 

3. Save as file type .RWX. (You must name the file PART1_0.RWX, PART2_0.RWX, or PART3_0.RWX.) 

4. To create a finished part, name the file PART*_1.RWX. There must also be a PART*_0.RWX file to 

go with it (i.e., in order for there to be a PART1_1 file there must be a PART1_0.RWX file). 

5. Copy the files to the SBWSIMn\RESOURCE folder. 

Note: It is recommended that you do not discard the original files supplied with RoboCell. Save 

the original files under different file names.  

6. To create a User Object, follow the above steps and name the file USER*.RWX. USER*.RWX files 

cannot be manipulated by the robot or machines. You must replace the original user object files. 

0. 

4.8.11.3. Import a CAD File 

You can create a 3D object in a CAD program, and import it to RoboCell. To import a CAD file do the 
following: 

1. Create a file in any CAD program. Save as *.DXF or *.3DC. 

2. Use the DXFtoRWX, or 3DCto RWX converter to convert the file to RWX format. 
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3. Name the files PART1_0.RWX, PART2_0.RWX, or Part3_0.RWX. 

4. To create a finished part, name the file PART*_1.RWX. There must also be a PART*_0.RWX file to 

go with it (i.e., in order for there to be a PART1_1.RWX file there must be a PART1_0.RWX file). 

5. Copy the file to the SBWSIMn\RESOURCE folder. 

To import a user object, follow the above steps and name the file USER*.RWX. 0. 

For more information on RWX files, consult a manual on RWX programming. 
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5. Working in RoboCell 
RoboCell integrates the SCORBASE robotic software with a graphic display module, which allows you to 
define (teach) robot positions and execute robot programs in a virtual robotic workcell. 

RoboCell’s user interface and menus are similar to those of SCORBASE. The main differences are 
detailed in this chapter. They include: 

 The graphic module, which enables position definition and SCORBASE program execution in a 
virtual or real workcell. 

 Additional options which facilitate the integration of SCORBASE in RoboCell are displayed in 
RoboCell menus. 

All SCORBASE operations, menu items and programming language are described in the SCORBASE User 
Manual. 

5.1. ROBOCELL MENUS 

When you open Robocell and select New Project, this window is displayed: 
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5.1.1. File Menu 

The following options are available in the File menu: 

 

The following table summarizes the options in the File Menu.  

File Menu 

Icon Option Description 

 
New Project 

This option opens a new untitled project. 

The new untitled project does not include a robotic workcell (3D window). 

To add a workcell, perform one of the following: 

 Select File | Import 3D model to open an existing workcell file. 

 Select File | Edit 3D model to open CellSetup and create a new 
workcell.  

 
Open Project 

Opens the Load Project window which lists SCORBASE files (without a 
virtual cell), and RoboCell files (that include a virtual cell 

 
Save Project Saves the project (program, positions and graphics) 

 Save Project as… 
Saves the project (program, positions and graphics) under a different 
name 

 Close Project Closes the currently open project 

 New Script Opens Notepad 

 Open Script Opens File Selector box for opening an existing Visual Basic script file 

 Print Program Prints the SCORBASE program 
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File Menu 

Icon Option Description 

 Print Positions Prints the positions defined by the user 

 Print 3D image 
This option prints the graphic cell. The output is an image of the current 
cell. 

 Print Preview 
3D Image 

Opens a dialog window that shows how the printed cell appears on paper 

 Print Charts 
This option opens a dialog box to select the chart of a specific axis for 
display or printout. Only one axis can be selected at a time. 

 Print Preview 
Charts 

Opens a window that displays the chart of the selected axis showing how 
it is displayed on paper 

 Import 3D Model 

This option opens the Import 3D Model window which lists graphic 
module files (*.3DC files). 

Select one of the files to open the graphic display module window. When 
you save the project, the current workcell is included as part of the 
project. 

 Edit 3D Model 
This option opens CellSetup. If the project already includes a workcell, 
CellSetup opens that workcell for editing. Otherwise, CellSetup opens with 
a new untitled empty cell. 

 View File 

This option opens the View File window which lists the following files: 

 Graphic module files (*.3DC) 

 SCORBASE programs (*.sbp) (Note: It is possible to copy and 
paste an sbp file into your own project.) 

 Position data (*.pnt) 

When you select a file, a window opens displaying that file. 

 Exit Closes RoboCell 

5.1.2. Edit Menu 

The Edit menu is identical to the SCORBASE menu, which is used to edit SCORBASE programs. See the 
SCORBASE User Manual (or Help file) for a description of this menu’s options. 

5.1.3. Run Menu 

The Run menu is identical to the SCORBASE menu whose options allow you to run the SCORBASE 
programs and send the robot home. 

If you select Options | Simulation, running a SCORBASE program runs the robot in the virtual cell. 

If you select Options | On-Line (and a robot connected to the computer) the virtual and real robot work 
together. 



 

‎5 Working in RoboCell 46 

‎5.2 Graphic Display Module 

5.1.4. Options Menu 

The Options menu is similar to the SCORBASE menu. The only difference is the Simulation option. When 
checked, the robot in the virtual cell runs according to the SCORBASE program instructions. See the 
SCORBASE User Manual (or Help file) for a description of this menu’s options. 

Note: Advanced Commands are detailed in the SCORBASE User Manual. The ViewFlex Commands are 
detailed in the ViewFlex User Manual. 

5.1.5. View Menu 

The View menu is identical to the SCORBASE menu whose options allow you to toggle the display of 
SCORBASE dialog bars and menus. 

5.1.6. 3D Image Menu 

The options of this menu are described in ‎5.2 Graphic Display Module on page 46. 

5.1.7. Window Menu 

The options of the Window menu offer screen settings that enable optimal use of the screen while you 
are carrying out various operations such as defining positions, programming, and running the SCORBASE 
programs. 

5.2. GRAPHIC DISPLAY MODULE 

The graphic module file is an integral part of a RoboCell project. Opening or saving a project opens or 
saves the RoboCell program, robot positions and graphic module data as one entity. 

You can open a new RoboCell project and then import a virtual cell from an existing project or a cell 
created using CellSetup (File | Import 3D Model). 

Only one CellSetup file/window can be opened at a time. 

When you open a project which already contains a workcell, the graphic display module window is 
displayed. 
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The 3D image portrays the robotic workcell and all its components. Using the graphic display tools 
described in Chapter 3, you can manipulate the image and view it from different angles by controlling 
the angle and position of the virtual “camera” that monitors the workcell. Other tools enable you to see 
other data related to the cell (such as object name, position or the number of part in a feeder). 

5.2.1. 3D Image Menu & Toolbar 

All graphic display tools are accessible from the 3D Image Menu. Frequently used tools can also be 
accessed from the toolbar.  

3D Image Menu and Toolbar 

Icon  Option Description 

 
Reset 3D Model 

This options returns the workcell image to the initial setting and position 
(saved in CellSetup). 

This tool is useful when you want to initialize the workcell before re-
running a program. 

 Top View Resets camera position to the top center point of the cell 

 Drag Image 

This option activates the drag mode in order to drag the entire image to a 
new position. 

Using the cursor, point and click anywhere on the image and drag it to its 
new position. The drag mode remains in effect until you select another 
option or press [Esc].  

 Camera Sub-options: 
The 3D image window displays the output of a virtual camera that is fitted 
in the workcell. Manipulating the camera determines how the image is 
displayed in the window.  

 Redirect Camera 

Selects the point that is always in the center of the screen (while rotating, 
zooming and changing the camera’s angle). 

The Redirect Camera mode remains in effect until you select another 
option or press [Esc]. 

 Follow me Camera 

This option enables you to follow the movement of any object (robot 
gripper, certain object, etc.) when the workcell is running. 

To select the point, choose a point on a moving object (part of the robot 
or an object). 

Press [Esc] to exit Redirect Camera. 

 
Save Camera Position 

This option saves the current camera position. Only one camera position 
can be saved. Saving a new position overwrites the previously saved 
position. 

 Restore Camera Position Restores the position recorded using Save Camera Position 

 Labels Sub-options: 

 
Object Names Shows/hides Object Name labels 

 Object Positions Shows/hides Object Position labels 
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3D Image Menu and Toolbar 

Icon  Option Description 

The label displays the X and Y coordinates of the object position that is 
relative to the coordinates of the 3D model. 

 Object Positions in Robot 
Coordinates 

Shows/hides Object Position Robot Coordinates 

The object position displayed is relative to the robot coordinates. The 
robot coordinates may be different from cell coordinates if: 

 The robot was moved after initial setting (in CellSetup). 

 The robot is equipped with LSB. When the robot moves, the 
position of objects relative to the robot changes. 

 Number Parts in Feeder 
Shows/hides a label that displays the number of remaining objects in a 
feeder 

 Send Robot Sub-options Select Options | Simulation to enable the Send Robot options. 

 

Send Robot to 
Object 

This option sends the robot to the selected object. 

Make sure the gripper is open before sending the robot to the object. 

This option is useful for defining a robot pick position. 

 

Send Robot to 
Point 

This option sends the robot to the selected point. The option is useful for 
defining a robot place position. 

 

Send Robot to 
Above Point 

Sends the robot to a point above the selected point on the table 

Default: point 100 mm above the selected point. 

 Options for 
Send Robot 

Opens the Send Robot Options dialog box enabling you to define the 
vertical offset values and the gripper’s orientation when Send Robot 
commands are executed 

 

The Send Robot Options dialog box is shown here: 

 

The settings remain in effect for all subsequent Send Robot commands. When the gun is selected, 
default gun settings are used automatically; user-defined settings are ignored. 
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By default, the robot moves to an object or point with the gripper perpendicular (-90) to the table and 
with no (0) rotation. 

You can also use the SCORBASE Manual Movement dialog box (see ‎6.1 Robot Manual Manipulation on 
page 51) to adjust the orientation (pitch and roll) of the gripper. You can then select the option Use 
Current to maintain the gripper’s orientation during subsequent Send Robot commands. 

The Z-offset value is used by the Send Robot to Object and Send Robot to Point commands. The Z-offset 
Above Point value is used by the Send Robot Above Point command. 

Robot Options 

Option Description 

Show Path When selected, a line showing the gripper path is drawn on the screen as the robot moves. The 
distance between the points is proportional to the TCP speed. 

Clear Path Clears the robot path that was drawn using Show Path 

Show Origin This option shows the origin of the cell at floor level (under the center of the robot’s base) as a 
red cross marked with X and Y axes. The positions of all objects are defined as relative to this 
point of origin. When manipulating the graphic display, the cross may disappear momentarily. 
This option is the same as Scene Origin described in chapter ‎4 CellSetup on page 11. 

Show Robot 
Work Envelope 

Displays the span of the robot’s working range, allowing you to see whether objects are within 
the reach of the robot. This option is the same as the Show Envelope option of the Robot 
Properties. 

Welding 
Settings 

This option opens the Welding Setting dialog box, which enables definition of the welding 
parameters. 
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‎6.1 Robot Manual Manipulation 

6. Cell Operation 
Operating and programming the robot in RoboCell is similar to working with a hardware robot. Graphic 
display features and automatic operations, such as Cell Reset and Send Robot commands, enable quick 
and accurate programming. 

6.1. ROBOT MANUAL MANIPULATION 

The SCORBASE Manual Movement dialog box allows you to manipulate the robot and peripheral axes in 
the simulated cell in the same way that it provides control of an actual robotic system. 

 

To move the virtual robot axes:  

 Click the keys on the Manual Movement dialog box, or  

 Press the corresponding keys on the keyboard. 

Movement of an axis continues as long as the button or key is pressed, or until a software or hardware 
limit is reached. 

Use the Open Gripper and Close Gripper buttons to control the gripper. 

6.2. MACHINE OPERATION 

You can operate the Mill or Lathe directly from the Digital Output dialog box, or with program 
commands (see ‎6.7 Program Execution on page 55). A program continues to run after the machine 
begins to operate. 

Be sure to close the chuck on the Mill or Lathe before you open the Robot gripper to release it. A part 
placed in the Lathe drops to the bottom unless the chuck is closed before opening the robot gripper. 

A part placed in the Mill may fall once the Mill cycle begins, if the chuck is not closed before starting the 
cycle. 

The Mill and Lathe work only if the door is closed. 

6.3. SEND ROBOT COMMANDS 

Send Robot commands can often be used instead of the SCORBASE Manual Movement dialog box. 
Commonly, however, the Manual Movement dialog box is used to adjust the robot’s position after using 
a Send Robot command. 



 

‎6 Cell Operation 52 

‎6.3 Send Robot Commands 

When SCORBASE is operating online with an actual robotic cell, the Send Robot commands and options 
are disabled. 

When using the Send Robot commands, be aware of certain characteristics of the following objects: 

Send Robot Commands 

Object Description 

Feeders Click the part in the feeder (and not the feeder itself), to select it as the target position for 
the Send Robot to Object command. 

To pick up a part from the feeder, select a pitch of 0° and a roll of (-90°) in the Send Robot 
Options dialog box. 

Lathe Each of the four clamps in the chuck can be a target object. You cannot use the Send Robot 
to Object command to place an object in the lathe. The object must be placed in the chuck 
manually. 

Only cylinders can be placed in the chuck. Use the Manual Movement dialog box to position 
the cylinder exactly.  

Mill Click the jig in the mill to select it as the target for the Send Robot to Point command. Use 
the grid on the jig to help place the object. 

Table Use the Send Robot to Point (not Send Robot to Object) command and select a specific target 
point on the table. The robot moves to that position with the offset defined in the Options 
for Send Robot dialog box. 

Template Although it is regarded as one object, the template is comprised of two objects, the tray and 
the handle, either of which can be a target object. The template has only one position, 
defined by the center of the tray. 

Use Z-offset 35 mm to send the robot to the template tray. 

Use Z-offset 0 mm (user-defined) to send the robot to the template handle. 
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‎6.4 Gripper 

6.4. GRIPPER 

The Gripper is a dynamic and important part of your robot. The features of the gripper are covered in 
the sections below.  

6.4.1. Grasping Objects 

The robot gripper in RoboCell grasps objects only as a result of Close Gripper commands. 

When the gripper closes on an object, the object is pushed into the center of gripper. 

In addition, cubes and horizontal cylinders are rotated into alignment with the gripper jaws, provided 
the rotation offset does not exceed 35º. When the offset is about 45º, the gripper simply grasps the 
object at its corners. 

Since objects are rotated around their center, a long object that is grasped far from its center must be 
aligned with the gripper as much as possible before the gripper is closed. 

6.4.2. Releasing Objects 

RoboCell operates in a gravitational field. Objects that are released from the gripper fall to the highest 
surface below them. 

If more than half of an object’s base rests on a surface, the object remains on the surface. Otherwise it 
falls onto the surface below. 

Objects can be picked up and released at any rotation. 

6.5. IMPACT DETECTION 

RoboCell checks for the following impact conditions: 

 The tip of the gripper hits an object or the robot itself 

 The edge of the gripper motor (mounted on top of the gripper) hits an object or the robot itself 

 An object held by the gripper hits another object or the robot 

RoboCell’s impact error message is the same one sent by SCORBASE when an actual robot cannot reach 
a target position. Since there are no mechanical (motor) or electrical (encoder) failures in simulation, 
you can assume simply that the gripper or an object held by the gripper has collided with the robot or 
another object. 

The Graphic Display status line indicates the object on which the impact has occurred. 

In response to the impact error message, click OK to resume Control On. Then move the robot away 
from the impact condition. If a Send Robot command caused the impact, the robot resumes movement 
from the position that preceded the Send Robot command. 

When SCORBASE is operating online with an actual robotic cell, SCORBASE controls impact detection 
and response, and Cell Simulation’s impact detection function is disabled. 
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‎6.6 Defining Positions 

6.6. DEFINING POSITIONS 

RoboCell provides the methods described below for defining robot positions. A position is identified by 
its assigned number. 

6.6.1. Recording Position #1 

To record position #1: 

1. Use the SCORBASE Manual Movement dialog box to manipulate the virtual robot in the same 

manner in which you would manipulate an actual robot. 

2. When the position is reached, type a number in the position number field in the Teach Position 

(Simple) dialog box. 

3. Click Record. 

If the position number has been used previously, the new position overwrites the previous position 
data.  

6.6.2. Recording Position #2 

To record position #2: 

1. To send a robot to a required position, use the Send Robot to Object/Position/Above Position 

tools. 

2. If needed, use the Manual Movement dialog box for fine-tuning. 

3. When the position is reached, type a number in the position number field in the Teach Position 

(Simple) dialog box. 

4. Click Record.  

If the position number has been used previously, the new position overwrites the previous position 
data.  
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‎6.7 Program Execution 

6.6.3. Teaching Position 

1. In the Graphic Display window, select View | Object Positions to view the X and Y coordinates of 

an object. 

2. Zoom in on the object or point whose coordinates you want to record. 

3. In the Teach Position (Simple) window, click the Expand button. The Teach Positions window is 

expanded. 

 

4. Type the position coordinates in the X, Y, Z, Pitch, and Roll fields. 

5. Enter a position number in the Position Number field. 

6. Click Teach.  

Note: If you click Record Position, the current robot position is recorded (and not the position defined 
by the coordinates you entered in the X, Y, Z, Pitch, and Roll fields). 

If the position number has been used previously, the new position overwrites the previous position 
data. 

6.6.4. Fine-tuning a Position 

To modify existing positions: 

1. In the Teach Position (Simple) window, click the Expand button. The Teach Positions window is 

expanded. 

2. Select the position you want to modify in the Position Number field. 

3. Click Get Position. The position data is displayed in the X, Y, Z, Pitch, and Roll fields. 

4. Modify the required coordinate. 

5. Click Teach to overwrite the previous position. 0. 

6.7. PROGRAM EXECUTION 

Executing programs in RoboCell is the same as executing programs when using an actual robotic system. 
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‎6.7 Program Execution 

Since different cell configurations can be loaded and changed in RoboCell, keep in mind that positions 
and programs are not loaded together with their workcell. 

To use a workcell with its positions for a new project: 

  In File | Save as, save the project with the workcell and positions under a different name.  

 Delete the program and write a new one (the positions and the cell remain unchanged). 
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‎7.1 Introducing Welding Features 

7. Welding Features 

7.1. INTRODUCING WELDING FEATURES 

RoboCell welding features contain 3D-solid modeling robotic welding options for teaching modern 
techniques of arc welding. 

The software features the following: 

 Welding of multiple parts both online and in simulation 

 Accurate display and manipulation of welded parts both online and in simulation 

 Single-command character generator that calculates and teaches all positions required for 
producing any text string 

 Predefined welding cells and fully functional demonstration programs for simulated execution. 

A typical welding cell is shown below. 

 

Welding features enable several types of welding processes: T-joint welds, butt welds and the welding of 
letters and numerals. 
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‎7.1 Introducing Welding Features 

 T-joint weld: A T-joint weld is shown below. It is in the shape of a letter T.  

 

 Butt weld: Weld in which the pieces are welded side-by-side. 

 

 

 Letters and numerals: A gun is used to weld letters or numerals on a large metal plate placed on 
the butt jig. 

 

The workcell allows fully automatic T-joint welding operations: 

 Retrieval of metal plates from gravity feeder 

 Loading of parts into T-joint jig 

 Retrieval of MIG gun 
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‎7.2 Welding Table Configuration 

 Arc welding 

 Returning of gun 

 Unloading of weld from jig for cooling 

Welding of a butt joint or of numerals/letters is performed similarly. However, for these processes, the 
metal sheets must be placed in the jig during the cell setup stage. The robot’s work envelope does not 
allow it to place and remove parts from this jig. 

7.2. WELDING TABLE CONFIGURATION 

The welding table should be placed in the cell just before or after the robot (the first object) has been 
placed. Most welding objects are automatically placed at the correct default welding table height, even 
if they are not placed directly on the welding table. 

The Welding Table Configuration dialog box is shown here: 
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‎7.3 Welding Machine Properties 

A table summarizing the options of the Welding Table Configuration dialog box is shown here: 

Welding Table Configuration 

Colors Opens the color pallet to define the color of the welding table. The booth poles 
remain default gray. 

To distinguish the table, use a color that is different from the colors used for the floor 
and background. 

X (mm); Y (mm) Defines the length and width of the table in millimeters. X and Y dimensions are 
always in accordance with the X and Y dimensions of the cell. (Use the Show Cell 
Origin option to display the X and Y origin of the cell.) 

You can accept or change the default dimensions of 1200 x 800 mm. 

7.3. WELDING MACHINE PROPERTIES 

The Welding machine supplies the electric energy required for the welding process to the welding gun. 
As such, you cannot save a cell containing only a welding gun or only a welding machine. Neither or both 
must be present in order to save the cell. 

To open the welding machine properties window, perform one of the following: 

 Select 3D Image | Welding Setting from the RoboCell main menu. 
 
Note: The Welding Setting option is only enabled if you have defined a welding machine and a 
welding gun in the cell. 

 Double click the welding machine image in the 3D window. 
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‎7.3 Welding Machine Properties 

The Welding Machine Properties menu contains the following additional option: 

Additional Welding Option 

Welding Settings Opens the Welding Settings dialog box which enables definition of the following weld 
parameters: 

 Voltage Tap 

 Wire Diameter 

 Wire Speed 

 Shielding Gas 
 

 

The Welding Settings dialog box is shown here: 
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‎7.4 Welding Tools 

The Welding Settings dialog box options are described in this table: 

Welding Settings 

Voltage Tap 

Sets welding machine voltage output supplied to the welding gun, an important 
variable in determining the quality and appearance of a weld. The voltage tap 
value is a reference number (2 in the image above does not indicate a voltage 
value). 

The voltage tap should be set according to several factors, such as robot speed, 
wire speed and metal thickness. 

Wire Diameter Sets diameter of the welding wire being fed to the MIG welding gun. This cannot 
be changed. 

Wire Speed 

Sets speed at which the wire is fed to the MIG welding gun. This is also known as 
feed rate. 

The wire speed setting is essentially a reference value to the controller built into 
the welder. Valid values: 10 - 100. 

The wire speed is automatically regulated by the welder for optimal performance 
and does not need manual input. The welder determines the feed rate setting by 
weighing three factors: type of shielding gas, metal thickness and wire diameter. 

Shielding Gas 
This option sets the type of gas for shielding the weld from oxidation, which 
causes rust and poor joining of the welded pieces. The system only works with 
CO2 gas. 

The default parameters are set according to the Millermatic recommended settings (see the Millermatic 
User’s Manual). 

Some parameters are interrelated. For example, changing the voltage tap causes the wire speed default 
to change automatically. Note that the wire speed can also be changed independently of the voltage 
tap. 

Welding settings can also be changed by the user when working within the Graphic Display window. The 
settings remain in effect for all subsequent simulated welds. 

Note: Changes in this dialog box do not affect the actual Millermatic welder settings. 

This dialog box can also be accessed by double-clicking the welding machine knobs. Note that parameter 
changes are reflected in the knobs’ positions. 

Additional Welding Settings 

Controller Output 
Number for Welding 
Machine 

The welding machine operation is controlled using a controller output. After 
placing the welding machine (in CellSetup) you should assign a free controller 
output for controlling the welding machine. 

7.4. WELDING TOOLS 

The welding tools available in CellSetup are described below. 

7.4.1. Gun Stand 

The gun stand does not require the user to define any additional configurations or properties. The user 
need only place it in an accessible position on the welding table.  
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‎7.4 Welding Tools 

CellSetup draws the cable that connects the welding machine to the gun. 

 

You cannot save a cell containing only a welding gun or only a welder. Neither or both must be present 
in order to save the cell. 

7.4.2. Welding Jig A (T-Joint) 

Welding Jig A is a device used to securely hold two materials being welded together in a T-joint. This jig 
does not require the user to define any additional configurations or properties. The user need only place 
it in a position on the welding table in which the robot can access the jig from both ends to place and 
remove parts. 

 

7.4.3. Welding Jig B 

Welding Jig B can be used for various types of welds. The grooved area in the center of the jig can be 
used to securely hold two metal sheets side-by-side to create a butt weld. The jig can also be used to 
hold the larger nameplates used with the SCORBASE Write command. For more information, see the 
SCORBASE User Manual. 

Welding Jig B (shown below) does not require the user to define any additional configurations or 
properties. You only need to place it in an accessible position on the welding table. 
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‎7.5 Welding Materials 

 

7.5. WELDING MATERIALS 

There are a number of available welding materials in RoboCell. These materials are covered in the 
following sections.  

7.5.1. Plate  

Plate refers to the welding metal plates which are used with Welding Jig A. When you select Plate, this 
dialog box is displayed: 

 

The options of this dialog box are described here: 

Plate Configuration 

Option Description 

Colors 

You can define the color of the plate to which the sensor is sensitive. The default color is blue. 
To change the color, click Colors. This opens a color palette from which you can select the 
required color. Make sure the color you select is compatible with the sensor’s detection 
definition. 

Size The default dimensions of the plates are 38 x 2 x 89 mm. These are for display purposes only 
and cannot be changed. 
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‎7.5 Welding Materials 

7.5.2. Metal Cube 

When you select Metal Cube, this dialog box is displayed: 

 

Features of the dialog box are described in the table below.  

Metal Cube Configuration 

Option Description 

Colors Define the color of the cube in the same way as described for the Plate. 

Size Any dimensions can be defined provided that the cubes are compatible with either welding Jig A 
or B.  
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‎7.6 Additional Welding Features 

7.6.  ADDITIONAL WELDING FEATURES 

The RoboCell’s Graphic Display includes various additonal welding features. These features are covered 
in the sections below.  

7.6.1.  Advanced Send Robot Commands 

This section describes advanced positioning commands for the robot.  

7.6.1.1. Recording Positions for Welding Jig A 

Welding features enable easier recording of positions for Welding Jig A. To record the position for 
placing a part in the left side of the jig, use the Send Robot to Object option and click anywhere on the 
protruding parts of the jig (indicated by the number “1” in the image below). RoboCell automatically 
sends you to the correct position for placing the part. Note that this position is also used for removing 
the welded part from the jig. 

To place parts in the right side of the jig, click any of the areas numbered “2” in the image below. 

 

7.6.1.2. Recording Positions for Welding Gun 

Welding features include a built-in feature to facilitate recording the pick position for the welding gun. 
To record the position for picking the gun, use the Send Robot to Object option and click the gripper 
adapter handle on the gun. RoboCell automatically sends you to the correct position for properly picking 
the gun. 
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‎7.6 Additional Welding Features 

7.6.2. Welding Booth Doors 

The welding booth doors can be viewed or removed by double-clicking anywhere on the booth. 

 
 

7.6.3. Welder 

The welder has the following built-in features: 

 

The built in weld features are summarized in this table. 

Built in Welding Features 

Feature Description 

Wire Spool Motion During the welding process, the wire spool turns just as it does in reality. 

Wire Speed, Voltage 
 and Power Switches 

The knobs on the welder accurately reflect the welding settings defined via the 
Welding Settings dialog box. 

Double clicking any knob opens the dialog box.  
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‎7.6 Additional Welding Features 

7.6.4. Welding Parameters 

Successful automated welding is often not the result of reliable technology, but of proper planning. 
Therefore, it is extremely important to work only with the optimal parameter settings defined by the 
manufacturer. The following welding parameters can be modified: 

Welding Parameters 

Parameter How to Change Parameter 

Inert Gas Shield From the Welding Settings dialog box, select either None or CO2. 

Voltage Tap From the Welding Settings dialog box, select one of the reference numbers. 

Wire Feed Rate 
From the Welding Settings dialog box, select one of the reference numbers. 

The wire feed rate automatically changes when the voltage tap is changed. 

Rate of Travel 

To define the rate of travel (the speed of the robot and the welding gun in the welding 
procedure), use the Duration setting in the Go To Position dialog box. 

By changing the duration it takes to get from position A (weld start position) to B (weld 
end position), the robot’s speed is changed – thus changing the speed at which it 
welds. 

Distance of Electrode 
from Materials to be 
Welded 

When recording the start/finish welding positions, you define this distance by defining 
the positions’ Z value. 

Welding only occurs when the electrode of the welding gun is located at a proper 
distance above “weldable” material. This feature was built-in to enable more accurate 
recording of the start welding position. 

Once the software recognizes that welding is “allowed”, the gun emits wire that 
creates a seam between the two materials. 

Welding does not occur in the following situations: 

 The electrode of the welding gun is too close or too far from the material. 

 The welding gun is located above a material that the software recognizes as 
“non-weldable”. 

Angle of electrode 
When recording the start/finish weld positions, you define this angle by defining the 
positions’ pitch. 
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‎7.7 Welding Process 

7.7. WELDING PROCESS 

RoboCell invites you to experience a realistic welding process. The process is covered in the following 
sections.  

7.7.1. Welding Gun Operation 

As welding occurs, sparks fly from the welding gun, as shown in this image. 

 

7.7.2. Weld Temperature 

Changes in the temperature of the welding seam can also be seen by zooming in on it during and after 
the welding. Immediately after the welding, the seam is red and yellow – indicating that it is extremely 
hot. Slowly, it changes to a grayish color – indicating that it has cooled. 

7.7.3. Welded Part 

After the welding process is completed, RoboCell regards the two metal pieces as one. A completed T-
joint welding process is shown in this image.  

 

7.8. WELD ANALYSIS 

RoboCell allows you to observe the quality of a weld at the end of the welding process. Depending on 
the welding settings used to create the weld, the appearances of welds may differ. 
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‎7.9 Replicating Real and Simulated Cells 

After welding two metals together, double-click the seam to open the Weld Properties window. 

 

The window displays the following information: 

 Status of the weld (e.g., good, bad) 

 Whether shielding gas was used or not. 

 Selected voltage tap value 

 Wire diameter used 

 Wire speed reference value that was used 

 Speed of the welding gun 

7.9. REPLICATING REAL AND SIMULATED CELLS 

RoboCell’s representation of robots and devices are based on actual dimensions and functions of 
SCORBOT equipment. Thus, programming performed in RoboCell can be used with an actual robotic 
installation. 

7.9.1. From Simulation to Practice 

Using CellSetup and Cell Simulation, create a cell, record all positions to be used by the SCORBASE 
program, write the SCORBASE program and verify program execution. 

Then, to construct an actual robotic installation that duplicates the simulated cell: 

1. Using CellSetup as a guide, place all objects and devices in their approximate locations. 

2. To print a 3D Image, select File | Print 3D Image. 

3. If necessary, hide labels and/or change the angle and zoom of the camera, and print several cell 

maps. 

4. Consider your SCORBASE program and determine which of the recorded positions must be 

precise; for example, the point at which the robot takes an object from a feeder, or the point at 

which the robot places a part in a machine. 
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‎7.9 Replicating Real and Simulated Cells 

5. In SCORBASE On-Line mode, send the robot to these key positions. Adjust the location and 

orientation of the actual objects and devices (e.g., feeder, machine) according to the location of 

the gripper. 0. 

If you are unable to relocate the object or device, you can record the position coordinates additional 
times. 

7.9.2. From Practice to Simulation 

To create a simulated cell based on an actual installation, you need to know the exact location and 
orientation of every element in the cell. 

If the cell layout is simple, this information can be obtained through a coordinate grid or a ruler. For a 
more complex cell layout, you may need a technical drawing (e.g., AutoCAD) which shows the center 
point and orientation of all objects. 

All measurements should be made with both the robot and the cell at the same point of origin and with 
the same orientation. 
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‎8.1 3D Project Descriptions 

8. Sample RoboCell Projects 
Your RoboCell package contains a number of sample projects to help familiarize you with the capabilities 
of RoboCell. These are accessible by means of the File Open command. Press Ctrl + O on your keyboard, 
select Open Project from the File menu, or click the Open icon in the toolbar. You are then shown a 
listing of all the *.WS files in the following default installation subdirectory: 

C:\Intelitek\RoboCell\Projects\ER 4u 

8.1. 3D PROJECT DESCRIPTIONS 

This section provides a description of the projects that are installed by default together with RoboCell. 

ER4Cell1 

Builds two towers, one of cylinders and one of rectangular blocks. This demonstrates the use of 
numbered positions. 

ER4Cell2 

Builds two towers from parts supplied by parts feeders. This demonstrates the use of named variables 
for positions. 

ER4Cell3 

Part sorting. This demonstrates the control of inputs and outputs. 

ER4CellCNC1 

Order cylinders and process parts. This demonstrates complex PICK movements and program control 
using IF statements. 

ER4CellCNC2 

This demonstrates visual representations of the path taken by the TCP (Tool Center Point) using the 
Intelitek ProLight lathe and mill. 

Butt Joint 

Picks up welding tool to weld two parts in a butt joint 

Excel_EX1 

This demonstrates the use of VBScript to transfer values from SCORBASE into Excel spreadsheets. 

Intelitek 

This demonstrates use of the SCORBASE “Write” command. 

MICROCIM 

Simulation of an OpenCIM device driver interface 

New Project 

Empty project 

Polygon 
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‎8.1 3D Project Descriptions 

This demonstrates the use of VBScript to transfer values from user input to SCORBASE and make 
floating-point calculation available to SCORBASE. 

RunProgram1 

This demonstrates multitasking implementation using the Run Subroutine command. 

Script Demo 

This demonstrates the interaction between SCORBASE and VBScript. 

Serial Port 

This demonstrates using RoboCell to send text messages via serial communications port. 

Tjoint 

This demonstrates complex pick & place movements and control of welding tool. 

 

 

 



 

‎9 Troubleshooting 75 

 

9. Troubleshooting 
This table covers problems that you may encounter when working in RoboCell.  

Troubleshooting in RoboCell 

Problem Solution 

The installation is 
unsuccessful. 

Make sure all applications, including anti-virus monitors and network drivers, are closed. 
Then try installing the software again.  

The program does 
not respond 
correctly. 

There may be a message box hidden behind the application window. Minimize the 
application windows to check for messages or prompts. 

The robot cannot be 
dragged to another 
position. 

By default, the robot is placed at the cell's point of origin to simplify the teaching of 
positions. 

The robot’s position can be changed only by means of its Properties menu. 

The screen layout is 
jumbled or 
crowded. 

Select View | Simulation & Teach or View | Simulation & Run to reset the screen layout. 

You can also select Options | Load User Screen to reset a screen layout that you set and 
saved previously. 

The peripheral axes 
do not move in 
RoboCell. 

When SCORBASE is operating on-line, the peripheral settings defined in the CellSetup file 
are not loaded; the peripheral setup defined in SCORBASE is retained. Simulated 
peripheral axes that do not match the SCORBASE definitions do not respond to 
SCORBASE commands in the Graphic Display. 
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